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Errata Detail

First version of this book (as indicated on the inside cover): v040120 published in April 2020

Second version of this book: v061020 published in June 2020. The corrections made to this 
version were largely cosmetic, fixed typographic errors, or added points of clarification.

• page 49: added a bullet to the first item in step 2 (the format was incorrect)

• page 54, step 2, changed the text from “Reuse content from the Notes window on a 
slide” to “Copy and paste content from MS Word onto a Storyline slide.”

• page 68, step 2, added the word “is” before the word “selected.”

• page 68, removed a misleading sentence from step 2

• page 68, updated the last paragraph to say “In summary, this trigger will take the learn-
er to the next slide in the scene when the learner clicks the Start Button. Are you curi-
ous about the Conditions area? You’ll explore this feature later.”

• page 81, moved the image inline

• page 84, multiple typographic errors fixed

• page 85, added “to the States area” to the end of a sentence in the middle of the page

• page 88, changed the second sentence in the Confidence Check from “This time, when 
you hover above the image of the grain you’ll see both a glow effect and the caption 
text.” to “Hover your mouse above the image of the grain to see both the glow effect 
and the caption text.”

• page 88, step 9, added a period at the end of the sentence

• page 89, fixed a few minor typographic errors

• page 100, added a new step 5 with instructions for formatting the text box

• page 100, new screen shot for step 6

• page 100, added a screenshot below step 9 showing a name typed into the Text Entry 
Field

• page 101, replaced the screenshot with an image that was cleaner

• page 103, moved the instruction to save (step 4) lower down (to step 7)

• page 104, made a word bold

• page 117, minor typographic error fixed

• page 122, added “for the Calculate button” to steps 3 and 4 to ensure clarity

• page 149, step 5, removed the words “slide 3.3”

• page 156, updated the name of the activity to “Insert a Matching Drop-down Slide”

Second version of this book: v032023 published in March 2023. One correction made on 
page 92 caused by a Storyline update. In the last version of the book, you are able to right-
click a layer and duplicate. In this version, duplicate is not available on any layer except the 
base layer.

• page 92, a modification was made to the step instructing you to select a layer and click 
the Duplicate icon
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The Authors
Kevin Siegel is a Certified Master Trainer (CMT), Certified Technical Trainer 
(CTT+), and Certified Online Training Professional (COTP). Following a 
successful tour of duty with the U.S. Coast Guard (where Kevin was twice 
decorated with the Coast Guard’s Achievement Medal), he has spent decades 
as a technical communicator, classroom and online trainer, eLearning 
developer, publisher, and public speaker. Kevin, who founded IconLogic, Inc., 
in the early 1990s, has written hundreds of training books for adult learners. 
Some of his best-selling books include “Adobe Captivate: The Essentials,” “Articulate Storyline: 
The Essentials,” and “TechSmith Camtasia: The Essentials.” Kevin has also been recognized by 
Adobe as one of the top trainers worldwide.

Kal Hadi is a Certified Technical Trainer (CTT+) and Certified Online Training 
Professional (COTP) with more than 20 years of experience in computer 
graphics, imaging, and electronic publishing. Kal is a graduate of the Rochester 
Institute of Technology Electronic Publishing graduate program. He is also the 
author of many books and papers in graphics and web publishing, including 
multiple books on Articulate Storyline.

IconLogic
Founded in 1992, IconLogic is a training, development, and publishing company offering services 
to clients across the globe. 

As a training company, IconLogic has directly trained tens of thousands of professionals both 
on-site and online on dozens of applications. Our training clients include some of the largest 
companies in the world including Adobe Systems, Inc., Urogen, Agilent, Sanofi Pasteur, Kelsey 
Seybold, FAA, Office Pro, Adventist Health Systems, AGA, AAA, Wells Fargo, VA.gov, American 
Express, Lockheed Martin, General Mills, Grange Insurance, Electric Boat, Michigan.gov, 
Freddie Mac, Fannie Mae, ADP, ADT, Federal Reserve Bank of Richmond, Walmart, Kroger, 
Duke Energy, USCG, USMC, Canadian Blood, PSA, Department of Homeland Security, and the 
Department of Defense.

As a development company, IconLogic has produced eLearning and technical documentation 
for Duke Energy, World Bank, Heineken, EverFi, Bank of America, Fresenius Kabi, Wells Fargo, 
Federal Express, Fannie Mae, American Express, Microsoft, Department of For-Hire Vehicles, 
DC Child and Family Services, DCORM, Canadian Blood, Cancer.org, MLB, Archrock, NEEF, 
CHUBB, Canadian Natural Resources, and Hagerty Insurance.

As a publishing company, IconLogic has published hundreds of critically acclaimed books and 
created technical documents for both print and digital publication. Some of our most popular titles 
over the years include books on HTML, Dreamweaver, QuarkXPress, PageMaker, InDesign, 
Word, Excel, Access, Publisher, RoboHelp, RoboDemo, iSpring, Presenter, Storyline, Captivate, 
and PowerPoint for eLearning.

You can learn more about IconLogic’s varied services at www.iconlogic.com.

http://www.iconlogic.com
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Book Conventions
In our experience, humans learn best by doing, not just by watching or listening. With this 
concept in mind, instructors and authors with years of experience training adult learners have 
created IconLogic books. IconLogic books typically contain a minimal amount of text and are 
loaded with hands-on activities, screen captures, and challenge exercises to reinforce newly 
acquired skills. This book is divided into modules. Because each module builds on lessons 
learned in a previous module, it is recommended that you complete each module in succession. 

Lesson Key
Instructions for you to follow look like this:

 choose File > Open

If you are expected to type anything or if something is important, it is set in bold type like this:

 type 9 into the text field

If you are expected to press a key on your keyboard, the instruction looks like this:

 press [shift]

Confidence Checks
As you work through this book, you will come across the image at the right 
(which indicates a Confidence Check). Throughout each module, you are 
guided through hands-on, step-by-step activities. To help ensure that you are 
understanding the book’s content, Confidence Checks encourage you to 
complete a process or steps on your own (without step-by-step guidance). 
Because some of the book’s activities build on completed Confidence 
Checks, you should complete each of the Confidence Checks in order.

Book and Storyline System Requirements 
This book teaches you how to use Articulate Storyline 360, which is part of the Articulate 360 
suite of applications. You can download a free 30-day trial of Storyline or purchase the 
subscription at https://articulate.com/360.

Once you have installed Articulate 360, you will have access to Articulate Storyline 360. 
According to Articulate, the following are the system requirements to use Storyline 360.

Hardware: CPU, 2.0 GHz processor or higher (32-bit or 64-bit). Memory, 2 GB minimum. 
Available Disk Space, 1 GB minimum. Display, 1,280 x 800 screen resolution or higher. 
Multimedia, Sound card, microphone, and webcam to record video and/or narration.

Software: Windows 7 (32-bit or 64-bit), Windows 8 (32-bit or 64-bit), or Windows 10 (32-bit or 
64-bit).

Backward Compatibility: Storyline 1 and Storyline 2 projects can be upgraded to Storyline 360. 
Storyline 360 projects cannot be opened or edited with older Storyline versions.

Importing Content: Microsoft PowerPoint 2010 or later (32-bit or 64-bit), Articulate Presenter 
'09, '13, or 360, Articulate Quizmaker '09, '13, or 360, Articulate Engage '09, '13, or 360.

Publishing to Word: Microsoft Word 2010 or later (32-bit or 64-bit).

Translation: Microsoft Word 2010 or later (32-bit or 64-bit).

https://articulate.com/360
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Storyline Projects and Assets (Data Files)
This book assumes that you have never used Articulate Storyline 360 before and that you don’t 
have anything to create Storyline eLearning besides Storyline 360 and a willingness to learn. 
This book teaches you how to use Storyline 360, step by step. The book also includes free 
project files and supporting assets, such as images, videos, and audio files that comprise typical 
eLearning courses.

Ready to get started? Let's begin by downloading the assets (data files) from the IconLogic 
server that you'll need for the projects in the book. 

Download Data Files
1. Download the student data files necessary to complete the lessons presented in this 

book.

 start a web browser and visit the following web address: 
http://www.iconlogic.com/pc

 scroll down to the Articulate Storyline Data Files section

 click the Articulate Storyline 360: The Essentials (2nd Edition) link

The download is a zipped file containing several folders and files. On most web browsers, 
a dialog box opens asking if you want to Save or Open the file. The image below is the 
dialog box you’ll see if you use Firefox. We suggest that you Save the file to your 
computer (the desktop is ideal).

2. Save the ZIP file to your computer. 

3. Once the file fully downloads, close the web browser.

4. Locate the Storyline360Data_SecondEdition ZIP file you just downloaded to your 
computer and unzip the file (we suggest extracting the files to your desktop).

The unzipped data files should now be on your computer within a folder named 
Storyline360Data_SecondEdition. As you move through the lessons in this book, you 
will be working with these files.

http://www.iconlogic.com/pc.htm
http://www.iconlogic.com/pc.htm
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How Articulate 360 Updates Affect This Book
Articulate releases updates to the Articulate 360 suite of applications which may cause a 
mismatch between what is shown in this book and on screen.

If something on your screen does not match what we show in this book, visit our Articulate 
Storyline page on the IconLogic website for possible book updates or errata information at: 
www.iconlogic.com/articulate-storyline-360-essentials-second-edition-workbook.html.

Should you get stuck and find no relief on your own or from the IconLogic website 
(www.iconlogic.com/articulate-storyline-360-essentials-second-edition-workbook.html), email 
Kevin or Kal directly for clarification. You can reach Kevin at ksiegel@iconlogic.com and Kal at 
kal@amananet.com.

Special Thanks
We truly appreciate the work of the proofreaders and beta testers who labored diligently to find 
as many typos and errors as possible in both this book and the supporting project files. 
Specifically, we would like to thank Ellie Abrams, Martin Rosoff, Amanda Christianson, 
Janay White, Victoria Hokana, Dan Earley, Patty DeLuca, and Don Finch for their efforts.

Contacting IconLogic
Web: www.iconlogic.com
Email Kevin: ksiegel@iconlogic.com
Email Kal: kal@amananet.com
Phone: 410.956.4949, ext 711

http://www.iconlogic.com/articulate-storyline-360-essentials-second-edition-workbook.html
http://www.iconlogic.com
mailto:info@iconlogic.com
http://www.iconlogic.com/articulate-storyline-360-essentials-second-edition-workbook.html
http://www.iconlogic.com/articulate-storyline-360-essentials-second-edition-workbook.html
mailto:kal@amananet.com
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Rank Your Skills
Before starting this book, complete the skills assessment on the next 
page.



How This Assessment Works
Ten course objectives for Articulate Storyline 360: The Essentials (2nd edition) are listed
below. Before starting the book, review each objective and rank your skills using the scale
next to each objective. A rank of  means No Confidence in the skill. A rank of  means
Total Confidence. After you’ve completed this assessment, work through the entire book.
After finishing the book, review each objective and rank your skills now that you’ve
completed the book. Most people see dramatic improvements in the second assessment after
completing the lessons in this book. 

Before-Class Skills Assessment
1. I can redock Storyline’s windows.     

2. I can add a Trigger to a slide object.     

3. I can edit a Slide Master.     

4. I can insert a Character.     

5. I can create a Conditional Trigger.     

6. I can create a Variable.     

7. I can create a Quiz.     

8. I can add a Motion Path.     

9. I can create a Drag-and-Drop question.     

10. I can Publish as HTML5.     

After-Class Skills Assessment
1. I can redock Storyline’s windows.     

2. I can add a Trigger to a slide object.     

3. I can edit a Slide Master.     

4. I can insert a Character.     

5. I can create a Conditional Trigger.     

6. I can create a Variable.     

7. I can create a Quiz.     

8. I can add a Motion Path.     

9. I can create a Drag-and-Drop question.     

10. I can Publish as HTML5.     

IconLogic, Inc.
www.iconlogic.com

Skills Assessment

No Confidence Confidence

No Confidence Confidence
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About Articulate 360 and Storyline 360
Articulate 360 is a suite of tools developed by Articulate (www.articulate.com). The tools include 
Storyline 360 (which is the focus of this book), Studio 360 (a collection of eLearning products, 
including Presenter, Engage, and Quiz Maker), Replay 360 (a screen recording tool useful for 
making video demos), and Peek (a desktop application that lets you record either Mac or PC 
screens). There are web-based applications as well, including Rise (a template-based online 
authoring tool for creating very simple and responsive courses), and Review (an online-based 
course review process where team members can comment and provide feedback).

When you start Articulate 360, you see the following application Launcher screen:

To use any of the tools that comprise Articulate 360, you must subscribe to the suite via 
Articulate’s website (www.articulate.com). To edit existing projects, or create new content, you 
need to keep your Articulate 360 subscription active. 

In addition to the tools mentioned above, Articulate 360 includes the Content Library 360 
containing a vast selection of professional templates, images, and other digital learning assets.

http://www.articulate.com
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Planning eLearning Projects
If you want to create eLearning, Storyline is an essential development tool. However, if your goal 
is effective and relevant eLearning, you’ll need more than Storyline. Consider the following:

 Why are you creating an eLearning course? You’d be surprised how many people 
start Storyline and just start creating content. This kind of development process might 
be well intentioned, but you really need to map out the entire course, including the way 
you are going to track learner comprehension (if that’s important to you). During the 
mapping process, you might conclude that your course isn’t appropriate for eLearning 
and move on to another course.

 Who is your audience? The way you teach children is different from the way you 
teach adults. For instance, children need praise and encouragement during the 
learning process; however, adult learners might find such praise and encouragement 
annoying.

 What exactly are you teaching, and is it appropriate for eLearning? Not every 
lesson in an instructor-led course can be effectively re-tooled for eLearning. For 
instance, if a course relies on breakout groups, group discussion, or collaborative 
work, those aspects of the course cannot easily be included in eLearning. Keep in 
mind that eLearners almost always work on their own with little or no interaction with a 
colleague.

 Does your project need to accommodate learners with special needs? If the 
answer is yes, you should budget approximately 30 percent more time to produce 
accessible eLearning.

 Do you want your projects to contain images, videos, and background music? If 
so, where will you get them? Also, are you going to use a template? If so, who is going 
to design and create it?

 Will there be annotations (written instructions and descriptions)? If so, who will 
write the content for the annotations? Do you need an eLearning script? Do you need 
a voiceover script?

 Is your course soft skills, or is it a software simulation? If it is soft skills, does it 
make sense to create most of the content in Microsoft PowerPoint and then import the 
presentation into Storyline?
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Budgeting eLearning Projects
Many new Storyline developers underestimate the time needed to produce projects. Although it is 
certainly easier and faster to create eLearning content than ever before, it still takes time. To 
determine your level of effort, the first thing you need to know is the total play time in minutes of 
your eLearning course. Once you have that number, you can calculate your level of effort.

As an example, let’s calculate how long it’s going to take you to produce a 60-minute eLearning 
course. Because you don’t want to create a single project that, when published, plays for 60 
consecutive minutes, it’s ideal to break the 60 minutes of content into chunks. We suggest that 
each chunk play for no more than five minutes. That means you will have 12, five-minute lessons 
(or modules). 

If you need to write the content for the course (somebody has to), you’ll need a script (page 11) 
and/or storyboard (page 12); and, if there’s voiceover audio, you’ll need a voiceover script. It 
could easily take you three hours to write a script to support each five-minute eLearning lesson. 
Therefore, you should budget at least 36 hours to write the entire one-hour eLearning course (12 
x 3=36). Depending on how fast you write, you could easily double those hours, meaning you may 
need to budget 80 hours for the writing.

In our experience, writing a voiceover script is easier than writing a step-by-step main script 
(voiceover scripts typically take us 50 percent less time to write). If you spent 80 hours writing the 
script, you should budget 40 hours to write the voiceover script. Once the voiceover script is done, 
you’ll also need to include time for recording the voice-overs, making corrections to the script 
post-rehearsal, and recording the simulations using Storyline.

Next comes the production process where you will need to add slide text (annotations) and 
images, interactivity, triggers, hotspots, variables, audio, animations, videos, software simulations 
or demonstrations, quizzes, and more. You should budget approximately two hours of labor to 
produce every single minute of eLearning in Storyline. Therefore, it could easily take 10 hours to 
produce a five-minute module. 

During the production process (detailed beginning on page 5), you’ll likely add audio or record 
audio files. And you may need to edit the audio files by performing common tasks such as 
removing unwanted noise.

When you are done producing the project, you will publish the finished lesson, upload the 
published assets to a server or Learning Management System, and test for scoring or interactivity 
errors. If errors are found, you’ll need to return to Storyline to fix problems. After fixing those 
problems, you’ll need to republish, repost, and then retest.

An eLearning development budget for a 60-minute eLearning course might look something like 
this:

 40-80 hours to write an eLearning script or create the storyboard to support 12, five-
minute lessons for a one-hour course

 120 hours to edit, produce, and test 12, five-minute lessons

 20-40 hours to write a voiceover script to be used by your narrator

 20-40 hours to record and enhance your own voiceover audio
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eLearning Development Phases
The infographic below offers a visual way to think about the eLearning development process and 
phases. A larger version of the graphic can be downloaded from www.iconlogic.com/skills-drills-
workbooks/elearning-resources.html.

http://www.iconlogic.com/skills-drills-workbooks/elearning-resources.html
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eLearning Development Process
We’ve listed the typical eLearning development process below. The list includes a skill level 
number indicating the level of difficulty for each task. The numbers range from 1 to 10, with 10 
indicating the most difficult task.

 Write It: Depending on the type of eLearning you’re creating, you may need multiple 
scripts. If you’re creating a soft skills lesson (life lessons such as conflict resolution or 
on-boarding), you’ll likely need a storyboard (see page 12) and a voiceover script. 
If you’re creating software simulations (something we cover in-depth during our 
“Articulate Storyline 360: Beyond the Essentials, Third Edition” book), you need the 
detailed instructions necessary to record the simulation with Storyline (see page 11). 
The writing phase is the most important step in the process. Without good scripts, you 
don’t have a good movie. Think we’re kidding? The lack of a viable script doomed 
movie classics such as Battlefield Earth, Barb Wire, Heaven’s Gate, Popeye, and 
Ishtar. (Skill Level: 10)

 Rehearse It: If you’re creating a software simulation, go through the script with the 
software you’ll be recording in front of you. Don’t skip any steps. You’ll be able to see if 
the steps in the script are incomplete or inaccurate before you attempt to record the 
steps using Storyline. (Skill Level: 2)

 Reset It: After rehearsing a software simulation, be sure to “undo” everything you did 
during the rehearsal. When you ultimately use Storyline to record the actual software 
simulation few things are more frustrating than coming across steps that have already 
been completed (requiring you to stop the recording and re-record). (Skill Level: 1)

 Record It: If rehearsals go well, recording the software simulation should be easy. 
(Skill Level: 2)

 Produce It: In this task you add captions, highlight boxes, text entry fields, spell check, 
add buttons, click boxes, animations, quizzes, audio, variables, triggers, conditional 
triggers, etc. (Skill Level: 8)

 Publish It: Although not a difficult task, if your project is large (lots of slides and 
audio), publishing could take some time. You cannot do any work in Storyline while 
your project is publishing. (Skill Level: 1)

 Post It: This is a broad category. Posting your project means different things 
depending on where your finished lessons are supposed to go. For instance, if your 
lessons are supposed to be uploaded into a Learning Management System (LMS), 
you have to set up the reporting features in Storyline, publish the project, and then 
upload it into the LMS. Then you need to test the lesson to ensure it scores correctly. If 
you plan to simply add the lessons to a web server, posting may be as easy as 
handing the published files off to your webmaster. (Skill Level: 2 or 3... or higher if your 
LMS is difficult to use)

 Test It: This task isn’t difficult, but it could take time. If you find a problem, you’ve got 
to go back and fix it, publish it, and then retest it. Some people argue that this step 
belongs above the Publish It process. We cannot argue with that logic. However, after 
testing the project, you still need to publish it, and as we mentioned above, if you’re 
working with an LMS, upload it and test again. (Skill Level: 2)

 Republish, Repost, Retest: If something doesn’t work when you test the posted 
version of your lesson, you have to return to Storyline and fix the problem. After that, 
you’ll Publish, Post, and Test again. (Skill Level: 2 or 3... or higher if you can’t resolve 
the problem)
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Designing Storyline Slides
Because much of the Storyline interface is similar to Microsoft PowerPoint, if you have used 
PowerPoint, Storyline may seem familiar to you. When working in PowerPoint, you insert slides 
when you need them and then populate those slides with text, images, animations... just about 
anything. The same is true when working in Storyline.

Of course, there are big differences between PowerPoint and Storyline, and you’ll discover those 
differences as you work through this book. What the two programs have in common is your ability 
to apply themes that quickly create visually-appealing slides with a click of your mouse. While 
those themes help make the slides look good, they also need to effectively convey your message. 
When it comes to building effective slides, here are a few things to think about:

 Bulleted Lists. There are certain occasions when a bulleted list is the best way to 
convey an idea. However, just because PowerPoint uses a bulleted approach to 
information by default doesn’t mean you have to use that format in Storyline. 

 Break Things Up. Try splitting the bullets up into separate slides with a single image 
to illustrate each point, or forgo the text altogether and replace it with a chart, diagram, 
or other informative image.

 Less is More. It is not necessary to have every bit of information you discuss also 
appear on the slide. Encourage your audience to listen and, if necessary, take notes 
based on what you say, not what is displayed on the slide. 

 To Animation or Not to Animate. Like PowerPoint, you can add animations to just 
about anything and everything on a Storyline slide. However, we suggest keeping 
animations to a minimum. While animations can be cool, they can distracting. And 
nothing says “High School Presentation Circa 1997” quite like a dancing animated 
image clumsily plopped on a rainbow gradient background.

 Simplify. eLearning lessons are plentiful—particularly bad ones. Trust us, your learner 
will not be impressed with how many moving, colorful parts each slide contains. 

 Photos vs. Images. Consider taking more of a photographic approach to the images 
you use. You can easily find stock photographs on the web using any one of a number 
of pay-for-use websites. There are many free sites, but keep in mind that to save time 
and frustration (and improve on the selection and quality), you might want to set aside 
a budget to pay for images.
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Fonts and Learning
There is no denying that the most important thing about eLearning is solid content. Read on to 
discover the many surprising ways fonts can affect your content.

Some Fonts Read Better On-Screen
eCommerce Consultant Dr. Ralph F. Wilson did a study in 2001 to determine if serif fonts (fonts 
with little lines on the tops and bottoms of characters, such as Times New Roman) or sans serif 
fonts (those without lines, such as Arial) were more suited to being read on computer monitors. 
His study concluded that although Times New Roman is easily read in printed materials, the lower 
resolution of monitors (72 dots per inch (dpi) versus 180 dpi or higher) makes it much more 
difficult to read in digital format. Arial 12 pt was compared to Times New Roman 12 pt with 
respondents finding the sans serif Arial font more readable at a rate of two to one.

Wilson also tested the readability of Arial versus Verdana on computer screens and found that in 
font sizes greater than 10 pt, Arial was more readable, whereas Verdana was more readable in 
font sizes 10 pt and smaller.

So should you stop using Times New Roman in your eLearning lessons? Not completely. 
For instance, you can still use Times New Roman for text content that is not expected to be 
skimmed over quickly or read in a hurry.

Source: https://www.practicalecommerce.com/html-email-fonts 

https://www.practicalecommerce.com/html-email-fonts
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The Readability of Fonts Affects Participation
A study done at the University of Michigan in 2008 on typecase in instructions found that the ease 
with which a font in instructional material is read can have an impact on the perceived skill level 
needed to complete a task.

The study found that if directions are presented in a font that is deemed more difficult to read, “the 
task will be viewed as being difficult, taking a long time to complete and perhaps, not even worth 
trying.”

The results of the study by Wilson indicate that it is probably not a good idea to present eLearning 
material, especially to beginners, in a Times New Roman font, as it may make the information 
seem too difficult to process or overwhelming.

Most Popular Fonts
We polled our “Logical” newsletter readers and asked which fonts they tended to use in 
eLearning. Here is a list of the most popular fonts:

 Verdana

 Helvetica

 Arial

 Calibri

 Times

 Palatino

 Times New Roman

 Century Schoolbook (for print)
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Fonts and Personas
If you are creating eLearning for business professionals, you might want to use a different font in 
your design than you would if you were creating eLearning for high school students. But what font 
would you use if you wanted to convey a feeling of happiness? Formality?

In a study funded by Microsoft by A. Dawn Shaikh, Barbara S. Chaparro, and Doug Fox, the 
perceived personality traits of fonts were categorized. The table below shows the top three fonts 
for each personality objective.

Source: https://soma.sbcc.edu/users/Russotti/113/personality_Shaikh.pdf

http://www.surl.org/usabilitynews/81/PersonalityofFonts.asp
https://soma.sbcc.edu/users/Russotti/113/personality_Shaikh.pdf
http://usabilitynews.org/perception-of-fonts-perceived-personality-traits-and-uses/
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Scripts for Software Simulations
When we have created text-based eLearning scripts or received them from clients, we’ve 
generally seen them in two flavors: paragraphs and tables.

Scripts in Paragraph Format
If you are creating a script for eLearning, your text should be formatted in a way that is easy to 
follow. You can format the script in paragraphs, but you will need to clearly label the parts. You 
may find that formatted paragraphs are all you need. However, we recommend a table or grid 
format for a script that will be developed into eLearning.

Step 1
Screen: Display the document

Action: Move the cursor to the Format menu and click Format

Caption: Click Format

Voiceover: Now let’s open the Format menu to get started with formatting the document.

Scripts in Table Format
Below is a picture of a script used to create an eLearning lesson. The script was created in 
Microsoft Word and is available in the Storyline360Data_SecondEdition folder (the file is called 
SampleScript).
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Storyboarding for Soft Skills
When the training objective is a soft skill, such as how to interact with others in the workplace or 
how to comply with legally required behavior, there may be no step-by-step process to spell out. 
Instead, you have to describe and demonstrate the behavior in a way that engages the learner. 
This is where the screen-writing part of writing training materials comes into play. 

You can present soft skills through slides or videos. Either way, the writing must be both clear and 
engaging. 

Here is a typical plotline for soft skills training.

 State a real-world problem, challenge, or requirement

 Illustrate what happens on failure

 Demonstrate and describe how to succeed

 Include a quiz or other evaluation

A storyboard, which can be made up of images, text, or both, allows you to plan what is pictured 
or acted out, as well as what is said for each slide or scene. 

Even if you are not an artist, you can sketch the basics of the characters, setting, and behavior for 
each scene. Take a look at the image below. We think you will agree that the drawings are not 
works of art. Nevertheless, you can tell that they depict two people meeting in the reception area 
of an office. (You’ll find a sample storyboard in the Storyline360Data_SecondEdition folder.)
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• Explore Slides and Windows, page 16

• Zoom and Magnify, page 18

• Explore Panels, page 20

• Preview the Entire Project, page 22
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The Storyline Interface
As you work through the lessons in this book, the goal is to get you comfortable with each specific 
Storyline area or feature before proceeding. Like any feature-rich program, mastering Storyline is 
going to be a marathon, not a sprint. Soon enough, you’ll be in full stride, creating awesome 
eLearning content using Storyline. But before the run comes the warm up. During these first few 
activities, you will familiarize yourself with Storyline’s user interface. Specifically, you’ll be 
instructed to start Storyline, open an existing project, and explore Storyline’s interface a bit.

Guided Activity 1: Explore a Finished Storyline Project
1. Start Articulate 360 and then Storyline 360.

The Articulate 360 Launcher opens providing access to all of the Articulate 360 Desktop 
and Web tools.

 on the Launcher, click Open to the right of Storyline 360

Note: You can start Articulate Storyline 360 independent of the Launcher shown 
in the first image above. However, if you access the Launcher first you’ll always be 
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notified if there’s an update available for any of the tools that make up the 
Articulate 360 suite.

Shown below is the initial screen you’ll see after you start Storyline 360. At the top left are 
quick links to start a New Project, Record the Screen, and Import content from other 
sources. If you’ve opened existing Storyline projects, those projects will be available in the 
Recent area. Beneath the Recent projects, you’ll find a Browse for more link that will let 
you find and open existing Storyline projects (you’ll be using that link next).

2. Open an existing Storyline 360 project from the Storyline360Data_SecondEdition 
folder.

 at the bottom left of the screen, click Browse for more

The Open dialog box appears.

 navigate to the Storyline360Data_SecondEdition folder and open 
Finished_Chesapeake_Stables_Project.story

The project opens. During the lessons presented in this book, you will learn how to create 
this eLearning course from scratch. It introduces you to a horse-boarding facility named 
Chesapeake Stables.

3. Close the project and reopen it using the Recent area.

 choose File > Close (do not save the project if prompted)

 from the Recent area, click Finished_Chesapeake_Stables_Project

By default, Storyline projects open in Story View. 
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Guided Activity 2: Explore Slides and Windows
1. Ensure that the Finished_Chesapeake_Stables_Project project is still open.

2. Explore slides and scenes.

 from the top of the Storyline window, double-click the slide labeled 1.1 A Guide to Our 
Facilities

The Storyline window changes from Story View to Slide View. At the left you’ll see slide 
thumbnails and a Scenes drop-down menu. The slide you double-clicked is open in the 
middle of the screen. At the right you’ll see some panels with additional options.

 from the left side of the Storyline window, click the Scenes drop-down menu and 
choose 2 Farm Culture

This project consists of seven scenes (a scene is a collection of related slides). 
You’ll learn more about the relationship between scenes and slides beginning in the next 
module when you create your first project from scratch and begin adding content.
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Scenes Confidence Check
1. Still working in the Finished_Chesapeake_Stables_Project file, 

spend a few moments exploring each of the seven scenes.

2. As you move from scene to scene, click and explore each of the 
slides within those scenes.

3. When finished exploring, close any open slides to return to Story 
View. (Note that open slides can be closed via the Close box in the 
slide’s title tab, which is shown below.)

When you’re in Story View, you’ll see the Story View tab at the left of the Storyline window.
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Guided Activity 3: Zoom and Magnify
1. Ensure that the Finished_Chesapeake_Stables_Project project is still open.

2. Open a slide.

 from the middle of the Story View window, double-click the slide labeled 
3.1 Farm Services

3. Zoom closer to the slide.

 click the View tab on the Ribbon

 from the Zoom group, click Zoom

The Zoom dialog box opens.

 select 200%

 click the OK button

Being this close to the slide makes it easer to view and edit the slide’s content. At this 
zoom percent, you will need to use the scroll bars to move around the slide.
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4. Change the slide zoom by using the Zoom slider.

 at the lower right of the Storyline window, drag the zoom slider left to zoom out 

Note: You can also click the plus and minus signs to change the Zoom.

5. Change the slide zoom to Fit in Window.

 from the Zoom group (on the View tab of the Ribbon), click Fit to Window

Note: You can zoom as far away from a slide as 10 percent and as close as 400 
percent.

6. Close the slide to return to Story View.
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Guided Activity 4: Explore Panels
1. Ensure that the Finished_Chesapeake_Stables_Project file is still open.

2. Open a slide.

 from the Story View window, scroll down and double-click the slide labeled 5.1 Feed 
Your Horse

3. Undock the Timeline panel.

 from the bottom of the Storyline window, drag the word Timeline to the middle of the 
window

The Timeline panel detaches from the bottom of the window and floats in its own window.

4. Undock the Triggers panel.

 from the right of the Storyline window, drag the word Triggers to the middle of the 
window

Now both the Timeline and Trigger panel are detached and floating in their own windows. 
Using this technique, you can customize the look and feel of the Storyline window based 
on the size of your computer display.
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5. Redock all windows.

 select the View tab on the Ribbon

 from the Grid and Guides group, click Redock All Windows

All of the panels (windows) return to their default locations.

6. Resize the Timeline panel.

 from the bottom of the Storyline window, drag the Timeline to the middle of screen

 resize the Timeline as necessary to see all of its objects

The Timeline allows you to control when slide objects appear onscreen. You’ll use with 
the Timeline throughout this book.

Panels Confidence Check
1. Still working in the Finished_Chesapeake_Stables_Project file, 

spend a few moments exploring some of the other panels/windows.

2. Undock some of the panels/windows (position them anywhere you 
want on your screen).

3. Redock all of the windows.

4. Close any open slides to return to Story View.
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Previewing
During the activities presented in this book, you will learn how to create the Chesapeake Stables 
project from scratch. At some point, you will finish the development process by publishing the 
project. Once published, the output can be viewed by learners on all kinds of devices (including 
desktop computers, laptops, smart phones, and tablets. 

Prior to publishing a project, it’s a good idea to preview the project so you can see how the 
content will look once published. Storyline includes multiple Preview options including Slide, 
Scene, and Project.

Guided Activity 5: Preview the Entire Project
1. Ensure that the Finished_Chesapeake_Stables_Project project is still open.

2. Preview the project.

 select the Home tab on the Ribbon

 from the Publish area, click the bottom part of the Preview icon (the arrow)

 choose Entire Project

The project is generated and opens in a Preview window. Most of the slides are 
interactive to some degree (there are slides with interactive buttons; others contain videos 
or drag-and-drop interactions).
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3. Preview the Responsive Playback options.

 ensure the Preview window is open

By default, you are previewing the project as a desktop user. However, Storyline projects 
can be used by learners on several types of devices. You can use the Preview window to 
get an idea of how your content will look on those devices.

 from the upper right of the Preview window, click Phone Landscape

The slide resizes to accommodate a smart phone.
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Previewing and Storyline Options 
Confidence Check

1. Close the Preview window. 

2. Select any slide in any scene.

3. Preview the scene.

4. Explore the other Responsive Playback options (Tablet Portrait, Phone Portrait).

5. Close the Preview window when finished.

6. Open any slide in any scene and then Preview just the slide.

7. Close the Preview window when finished.

8. Close the slide.

You’ve just about wrapped up your initial Storyline tour. Before moving on to the next 
module (where you’ll create the Chesapeake Stables project from scratch), there are 
some additional Storyline options you should explore.

9. Choose File > Storyline Options.

10. From the list at the left, click General.
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11. Click the Reset “Don’t Show Again Prompts” button.

12. Click the OK button.

There are several dialog boxes in Storyline that ask you to confirm your action (as shown 
in the image below). Those dialog boxes may contain the option Don’t ask again. If you 
accidentally clicked Don’t ask again, resetting the option is a great idea.

13. Click the Spelling Options button and, at the bottom of the dialog box, click the 
Restore Defaults button. The default Spelling Options will be selected in the Spelling 
Options dialog box.
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14. Click the OK button to close the Spelling Options.

15. From the list at the left, click Features.

16. Ensure that Use the new trigger workflow is selected.

You’ll learn about triggers soon. The new trigger workflow makes working with triggers 
faster and more efficient. However, if you’re an experienced developer, you might prefer 
the Classic workflow. In that case, you would remove the checkmark from “Use the new 
trigger workflow.” For this book, ensure that the option is enabled.

17. Click the Cancel button to close the Storyline Options dialog box.

18. Close the project without saving.
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